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Operation

STEP 1 - Save/Copy your data.
Save messages from Newsgroups or Email in a file or files, or copy the complete message to the clipboard. Include as much header
information as possible, such as subjects and part numbers.



STEP 2 – Open or Paste the file or files in UUDWin.
You may open the file(s) manually, double-click on the file in File Manager or Explorer if you have saved the file with an extension
associated with UUDWin (see Preferences Dialog ). You may drag & drop the file(s) onto the UUDWin window, or you may paste text or
files from the Windows Clipboard.

- UUDWin will now process the files. -
As encoded files are detected, they will appear in the Output Files Listbox in black. When the input files have been processed, UUDWin
will color code the output files.
Green files are complete.
Blue files have a beginning, but may be missing pieces or are otherwise incomplete.
Cyan files are being stream decoded. (See Advanced Features ).
Gray files are incomplete, and can not be extracted unless part of a multipart message.
Red files have more parts than expected. Red files are extremely rare since UUDWin usually drops duplicate parts automatically.

Duplicate filenames are renamed using sequential numbers starting with “01”, or if the filename is numeric, a text count starting with “aa”
is used.
You can display the status of a file in the Output files listbox by clicking on it with the right-mouse button or by selecting it and then
selecting Edit/Properties. (See Popup Status ).

STEP 3 - Extract the files.
Now you may choose to extract one or all files to a directory by selecting one or more output files and clicking on the Extract button.
This brings up the Extract dialog .

You may also double-click on a file in the Output Files Listbox to launch the application associated with the file extension. For instance,
double-clicking on a file with the name "picture.jpg" will extract the file in the Working directory, launch the application registered as a
viewer of .jpg files, using "picture.jpg" as an argument. Once the application has been launched, UUDWin will monitor the close of the
application, and clean up the temporary file.

You can also click on a file or files, and drag it to another application that supports drag & drop operations such as Windows Explorer.

If any decoding errors occur during the extraction phase, a short beep and flashing status bar will alert you to additional information
contained in the Log Window

STEP 4 - You’re done!
When you are done, exit UUDWin or click on the Clear button to free up memory for more files.

Advanced Features

Stream Decoding

Stream decoding is a way to extract files from multipart messages while the data is still being received. This feature is easiest to use
with the monitor file option but doesn’t have to be used this way.

How to use stream decoding:

 Click on the Stream Decode toolbar button and set the destination folder.

 Select a number of messages to download in your favorite newsgroup reader or other program.
 Save these messages to one file.
 After the first message has been received, open that file in UUDWin. The file in the output files listbox will be decoded. The
name is drawn in cyan while it is being stream decoded.

 Double-click on the input file to begin monitoring and decoding additional parts.
 Now until the file has been completely decoded, UUDWin will automatically add newly received data. If message parts are
received out of order, UUDWin will skip back in the output file, and insert each piece in the correct order. If you start decoding
before part one is received, the destination filename may not match the filename listed in the output files listbox. (The
destination filename will not be changed once decoding has begun.)



UUDWin will allow other programs access to the decoded file during this process, so that you can preview the file without having to wait
for all the pieces to download. Because decoding goes on as pieces are received, you will not need to spend time extracting the file
once it has been completely downloaded.

Shared Access

When Stream Decoding, UUDWin will keep the output file open, but will allow shared read access. If the file was not kept open, other
programs could get exclusive access, preventing UUDWin from writing to the file. However not all programs are designed to open files
in read-only mode, thus some programs will not be able to access the output file until UUDWin has finished writing all parts and closed
the file.

The number of files you can stream decode at once depends on the number of file handles available, but you should easily be able to
decode several dozen at once.

Other features

DDE support
UUDWin supports several DDE commands, including opening files via DDE. The format of the command is OPEN(``filename``). The
service name is the same as the EXE name, UUDWin.

Drag file support
UUDWin allows you to drag a single file from the Output Files listbox to other applications that support Drag & Drop operations. When
you drag a file to another application, UUDWin will temporarily extract the file into the Working Directory Note: this file will be deleted
when another drag operation is performed or UUDWin terminates! Only a single file is dropped at a time. You can also drag a file into
the directory presented in File Manager, as an alternative way of extracting a file.

UUDWin also supports opening .lnk (link) files, and opening directories. When opening directories, no sub folders are scanned. All files
in a directory are scanned for data. You may specify wildcards when opening files from a command-line.

Input File monitoring
UUDWin can monitor input files for additions automatically. As another application adds messages to a file, UUDWin will update the
Output Files list with any additional encoded files that it finds. To enable this feature, simply double-click on the file in the Input Files list.
The file will be marked with “>”. This feature works great with Internet News readers such as WinVn which can append multiple
messages to the same file. This allows you to view & decode files while downloading! Turn this option on by default using the Advanced
Preferences Dialog .

Recursive file decoding
Sometimes files are encoded multiple times, and must be decoded multiple times to get back the original data. When UUDWin
encounters a nested file it will alert you when the file is being decoded. If the buried file has a different file name than the original, the
data is temporarily added to the Clipboard file and the filename is added to the Output Files list, otherwise the extraction continues
without interruption. UUDWin will decode up to 4 nested levels at one time.

Missing End of Line characters.
When pasting text from the clipboard, the data is scanned for missing end of line characters. If unusually long (1K) lines are detected
within the first 16K, UUDWin will attempt to replace the missing characters before processing the data. This function is not performed on
files opened any other way.

Log Window
TheLog window contains the history of activity. Decoding errors and line numbers as well as other status information is also shown.
Invoke from the menu or by pressing F11.

Large file support
UUDWin can quickly and easily decode files containing hundreds of messages and encoded files. It can support input files of any size.

Shell extension
You can use the right mouse button to click on a file associated with UUDWin. This will bring up an “Extract here:” menu item that will
start UUDWin and extract any files found into the same directory.



Extract Raw
You may download a large number of messages a to a single file, only to find out that a part is missing. Using Save Raw from the File
Menu, you can extract output files in their original encoding format, sorted & filtered, which allows you aquire & join the missing part later
without having to keep the whole message file. Raw files are extracted using the filename with a ".uu" extension. You may need to
disable extended part matching later to join files.

Command line arguments

filename(s)
You may specify a file or files to be processed on the command line. For example, invoking the program with "UUDWin
c:\mymessage.uue" will launch UUDWin, and have it process the file c:\mymessage.uue. You may use the wildcards “*” or “?” when
specifying filenames. You can open .lnk (link) files and directories too. Opening alternate data streams is possible by specifying a :
between the filename and the stream name such as c:\mymessage.uue:mystream

/ReadClipboard
Instructs UUDWin to process text or files stored on the Windows clipboard. It is unusual to have files on the clipboard, but can be done
by selecting files using Windows Explorer then selecting copy.

/OutDir=path or *
Specify the destination directory for extracted files. The directory must exist otherwise UUDWin will be unable to automatically extract
the files specified on the command line. When used in conjunction with the /Extract argument, the special character "*" may be used to
specify that the decoded files should be written to the directory where the input file(s) are located.

/Extract
Instructs UUDWin to process input files, extract any output files, and terminate without user intervention. Incomplete files are ignored.
Files are written to the last used output directory if it exists, or to the directory specified with the /Outdir= argument.

/Report=path
Generates a status report for each file found in input file(s). SeeReport Format Order is important, make sure this command comes
before input files if you want input information, or before /extract if you want decoding information.

/Logfile=path
Saves the contents of the log window to the specified file. Order is important, make sure this command comes before input files if you
want input information, or before /extract if you want decoding information.

/Listdump=path
Generates a detailed report for each sorted part in input file(s)

/UnInstall
(Manual uninstall.) Instructs UUDWin to remove or restore all registry entries and file associations that it has modified & delete its .ini
file. Then simply delete the program to remove all traces!

Extract dialog

Extract to:
You may specify the destination directory for decoded files in this edit box. If the directory does not exist, UUDWin will create it for
you, even multilevel subdirectories. You may specify as many subdirectories deep as Windows allows. UUDWin will prompt you for
confirmation before the new directory is created. You may also select a previously used directory from the recently used directories
drop-down list. The special character "*" may be used to specify that the decoded files should be written to the directory where the input
file(s) are located. You may also specify network volume paths such as “\\host\vol\directory”

Files:
You may override the default selections made in the Output Files listbox with these controls.

Selected
Extracts only the files selected in the Output Files listbox.



All Files
Extracts all of the files in the Output Files listbox.

File:
You may specify a particular file by entering a name. Wildcard characters (?, *) may be used to specify multiple files, case insensitive.

Skip Incomplete Files
When this option is checked, all files displayed in gray or blue in the Output Files listbox are ignored. Only complete files are extracted.

Overwrite Existing Files
By default, UUDWin will warn you before over writing an existing file. When this option is checked, no warnings are issued.

Append All to One File
This is a rarely used feature that allows all extracted files to be appended to an existing file, or to the first file extracted. You must check
this box each time you want to use it. Files will be extracted in the order presented in the Output Files listbox. To append to an existing
file, choose the file in the Save As dialog. If there is an error during extraction, the file will be removed.

You Choose Duplicate Part
Instructs UUDWin to let you decide which duplicate part to use when there is a choice. Normally UUDWin can decide this for you. This
setting affects launching files by double clicking and drag & drop operations.

Directories and Drives
You may use these controls to specify the destination directory for decoded files.

Preferences Dialog

File Types to Associate with UUDWin
By enabling or disabling the checkbox next to an extension, you control what file types are associated with UUDWin, and which
application gets launched when double-clicking on a file with one of these extensions. UUDWin will preserve any existing entries if other
applications use the same extension. If you wish to restore a previous association, just uncheck the extension. Each time the
preferences dialog is brought up, the system registry is scanned for UUDWin's entries, so the display is always accurate, even after
other applications have changed them.

Enable Indented Message Detection ( > )
Occasionally you may get a message where all lines are indented with spaces or " >" making the message unreadable by other
decoding programs. By enabling this option, UUDWin will scan each message for indented parts. Allowed indented characters are
<Space>, "-", and ">". Sometimes this can cause invalid data to be interpreted as an encoded file, so that is why this is an option.
Default Off.

Find & Decode Plain Text Encoding
UUDWin was designed to extract binary file attachments, but sometimes a text message precedes the binary attachment with
information. When this option is enabled, MIME Text/Plain data is shown in the Output Files listbox as “messageX.txt” where X is the
message part number. There may be multiple message.txt files listed. Default Off.

Find & Decode Quote-Printable Encoding
When this option is selected, UUDWin will decode attachments encoded in MIME Quoted-Printable encoding. It is very rare to find
binary attachments encoded with Quoted-Printable, however text attachments or messages that accompany binary attachments
frequently use Quoted-Printable encoding. By disabling this option, UUDWin will ignore Quoted-Printable attachments, which may not
be desired when you are interested in decoding only binary attachments. Default On.

Decode X-Face: & Face: images
When this option is selected, UUDWin will decode X-Face and Face headers sometimes included in USENET posts. X-Face are 48x48
1bit images, Face are PNG encoded images. X-Face images are decoded in Windows BMP format.

Decoding



Use strict decoding rules for yEnc messages.
When enabled, UUDWin will use a more strict method to decode yEnc encoded files. Line length limits are imposed, relaxed CRC errors
are disabled, and wrapped lines are not rejoined. Default off.

Disable duplicate filename renaming
Normally when duplicate output filenames are detected, UUDWin appends a version to the filename, starting with 01 if the file ends in a
non-numeric character, or 'aa' if the filename ends in a numeric character. When this option is checked, filenames are not renamed.
However if you extract the files to the same directory, you may overwrite previously decoded files. Default off.

Remove Duplicate Single Parts
Sometimes you will receive several files sent as single part files with the same filename. By checking this option, only a single part will
be retained. Default off.

Remove Duplicates in multi-part files
Occasionally messages contain one or more duplicate sections, or duplicate messages are sent to replace a bad or damaged message.
UUDWin will compare duplicates based on encoding, part numbers, and size, and keep the most promising parts. If you disable this
feature, all parts will be kept. Default On.

Enable Extended Part Matching
When this option is checked, UUDWin will use the full subject of a message to group parts together. This prevents messages that have
similar filenames from being mistakenly grouped together or discarded. When this option is unchecked, UUDWin will only use the
filename part of the message's subject. Uncheck this to decode files where the subject is inconsistent. Default On.

Assume Sorted Message Order (last chance)
This option is used as a last resort. Sometimes messages will be posted where the subjects contain useless or incorrect data. UUDWin
may be confused by these lines, and won’t be able to successfully decode multiple part files. When this option is checked, UUDWin will
ignore the subjects, and process the file assuming that the parts are already in sorted order. It is up to you to save the pieces in the
correct order. Mime encoded messages may still have part number information which is used.

Working Directory
This option allows you to change the Working Directory which is used for temporary files and files extracted when launching
applications. It defaults to the windows temporary directory. It you enter a directory that doesn’t exist, it will be created for you.

You should make sure this directory is not used to save extracted files!

Advanced Preferences dialog

Use old style drag & drop (Non OLE)
When checked, UUDWin will use the old Win3.x style drag & drop. Most applications support this form of drag and drop but the Win9x+
& WinNT4+ shell do not. This may make drag & drop faster in some situations, or prevent accidental dragging to the desktop. Default
off.

Use old Shell sytle Extract Dialog
When checked, uses the old windows save extract dialog instead of the customized Shell Style Common File Dialog. Not available in
x64 builds.

Expand escaped URI filename characters (i.e. %20)
When this is enabled, UUDWin will convert the encoded hexadecimal characters in filenames to the ASCII equivalent. When you see a
%20 in a filename it is converted to space, %2D to + etc. Default on.

Decode UTF-8 plain text data to ANSI
When this is enabled, UUDWin will convert the encoded UTF8 characters in quoted-printable & plain text to the ANSI equivalent based
on you current locale. Not all characters will convert, unknown characters will be replaced with '?' UTF8 is a method of encoding
unicode data to be backwards compatible with ASCII.



Enable Monitor mode by default.
When enabled, new files added to UUDWin are monitored for additions automatically. No need to double-click the input file to enable
this. See Monitored files. Default off.

Extract QP (Quoted-Printable) Text with PC End of Line (CR/LF)
Files created on other platforms do not always use the same end of line characters as DOS/Windows. When this option is enabled,
each end of line in a MIME quoted-printable encoded file will be extracted using DOS/Windows end of line characters. (CR/LF) Default
On.

Close stream decode files between updates
When stream decoding, the output file is normally kept open for additions. When this option is checked, the output file is closed between
updates. This allows other programs complete access to the file & but may prevent additional data from being written. When UUDWin is
denied access, the output file color changes to purple until access is allowed, or stream decoding is disabled.

Resume Stream decode mode on startup
When this option is checked and stream decode mode is enabled, stream decode mode will be reenabled on startup.

Add File Extensions for Recognized Files
Not all decoded files will have the proper extension for Windows. UUDWin can recognize many of the most commonly used file types.
When this option is enabled UUDWin will put what it thinks is the proper extension for a given file. It is not 100% accurate though, which
is why this is an option. Default On.

Only use last (n/n) in subject for part numbers
Some messages include multiple (x/y) part number in their subjects. UUDWin tries to figure out which one to use as a part number, but
is not always successful. Use this checkbox to have UUDWin only use the last (x/y) found in the subject as a part number.

File type to detect & allowed extensions
Place a check mark next to the filetype UUDWin should automatically detect & verify for proper extension.

Menu Items

The File Menu

The Edit Menu

The Options Menu

The Help Menu

Frequently Asked Questions

Why are files encoded, and why do I need UUDWin?

Files are encoded into a standard set of text characters that are able to pass through a any number of networks and gateways,
hopefully unchanged. Binary files are not able to pass through these networks unchanged. In addition, files may be split up into multiple
smaller pieces for easier transmission. Even though there are well-defined rules to follow when encoding files, not all programs follow
them. UUDWin was designed to handle encoded files that do not strictly follow the rules. UUDWin is able to decode files that other
programs can not decode, and present them in an easy to use way.

How are files encoded?

Generally, binary files are encoded by converting three 8-bit values into four 6-bit values. The 6-bit values are used as an index into a
standard set of text characters for transmission via mail and news. Encoding increases the size of the files by at least 4/3 or 33%, or
more!

One of the oldest and most popular encoding formats is UUEncoding. Later, a variation of that encoding scheme known as XXEncoding
was developed, which tried to get around certain limitations of the UUEncoding format. A more structured mail format that is known as
MIME (Multipurpose Internet Mail Extension) was created, which introduced Base64 and Quoted-Printable encoding schemes. A new



format know as yEncode takes advantage of 8bit data paths to produces smaller encoded files. And finally, a format that was made
popular on the Apple Macintosh known as Binhex continues to find use on other platforms. Another even more rare format called B-
News occasionally leaks out onto the internet. The UTF-7 format is similar to quoted-printable in that non-ASCII characters are encoded
along with plain text characters in a message, but it is intended for Unicode character sets. An archaic custom encoding format specified
the decoding table as the word "Table" followed by two 32-character rows totalling 64 characters to use as the decoding character set.
The rest of the file format is the same as UU/XX encoding.

What are the .apl files that show up in the Output Files Listbox?

Sometimes when decoding a message, UUDWin will add two files, such as picture.gif and picture.apl. The .apl file is the Mime-type
application/applefile, which contains data specific to the Apple Macintosh. It has no purpose on Windows, but is preserved anyway.

Distribution

UUDWin is free. You may give this unmodified software to friends and colleagues who might find it useful. However you may not include
this software on a shareware or freeware CD-ROM nor may it be sold by itself or in a collection without the prior written consent of the
author.

Permission to use and distribute UUDWin for any purpose and without fee is hereby granted, provided that you don't profit from
UUDWin directly. This software may be distributed as long as this notice remains intact and the software is not altered in any way. This
software may not be sold for profit.

Disclaimer

This software is provided "as is" without any warranty, expressed or implied. If you use this software, you do so at your own risk. Neither
the author nor any other party will accept responsibility for any data loss, equipment damage, or other unforeseen consequences or
damages that arise as a result of the use or misuse of this software.

Introduction

UUDWin is a hassle free Windows 32bit/64bit compatible program designed to make it easy to quickly extract binary files encoded in a
variety of formats commonly used to send data through Email and the Internet. Files are encoded so that binary (8 bit) data can travel
through paths that only support text (7 bit data). UUDWin supports UUENCODE, XXENCODE, BINHEX4, MIME BASE-64, MIME
Quoted-Printable, MIME Text/Plain and the experimental yEncode encoding and BNews formats. It’s the easiest to use most forgiving
message decoder available for the Windows platform!

UUDWin needs no special preprocessing of encoded files. The encoded files may be stored in a single file, or in multiple files, and in
any order. Pieces are automatically sorted. Duplicate parts are ignored. Messages may contain multiple encoded files in multiple parts.

UUDWin uses a relaxed approach to decoding messages, thus it can usually figure out what to decode even when missing some
header information. You can use it to extract files without any message headers at all!

UUDWin uses a simple Windows style interface, giving you two lists to work with, a list of input files, and a list of decoded output files.
You may input data via File Open, Drag & Drop, Clipboard Paste, Command line arguments, or DDE. Output filenames are
automatically detected from the input files. Output files are color coded to show you at a glance the status of the decoded file. Once
processed, files may be extracted individually, all at once, or you may double-click on the file to launch the associated application. This
is handy when dealing with many messages saved from USENET newsgroups.

Special features include automatic filename validation/renaming, automatic file extension generation, estimated extraction sizes,
indented message processing, color coded output files, drag & drop support, popup file info, input file monitoring, stream decoding,
application launching, recursive file decoding, log window, DDE operations, large file (4GB), and batch support.

UUDWin has been tested and works on Windows NT4, 2000, XP, Vista, Windows 7, 95, 98, & ME.

Keyboard Shortcuts

<Alt><Enter> Show popup info for file with focus in output files listbox.



<Alt><x> Invoke the Extract dialog.

<Shift><Alt><x> Extract to last used directory without invoking the Extract dialog.

<Shift><Enter> Run file with focus in output files listbox.

<Ctrl><Del> Remove selected file(s) from output files listbox.

<Del> Remove selected input file(s).

<Ctrl> O Open file(s).

<Ctrl> C Copy file (Temporarily extracts file with focus or selection in output files listbox)

<Ctrl> V Paste text data or file(s)

<Ctrl> A Select all output file(s)

<Esc> Stop operation

<F2> Rename output file(s)

<F8> Rename from Subject

<F5> Refresh output file listbox

<F11> Show log window.

Known Problems

When there are multiple files encoded in multiple parts, the status color (complete or incomplete)
of an individual file is not shown. Rather it is the status of all parts. An individual file may be
displayed in blue (incomplete) when in fact it is complete.

When launching an application from UUDWin, UUDWin will extract the file into the working
directory. When the application terminates, UUDWin will delete the file. If the launched application
launches another application, UUDWin may prematurely delete the file. For example, with Win95, if
a .txt file is extracted which is too large for Notepad, Wordpad will not be able to find it. Simply
extract the file, or drag it to the application.

UUDWin does not detect the type of Microsoft application when decoding newer MSWord, MSExcel,
or MSPowerPoint files, only that it is one of these types. The file extension will not be changed if
there is one, otherwise it will default to  .doc .

Popup Status

When files are displayed in the Output files listbox, you can get additional information about a file by clicking on it with the right mouse
button. This is especially useful for incomplete (blue) files. The following information is displayed:

Subject:
The subject of the message or messages used to group parts. You can see the original filename minus the part numbers.

Filename:
The name and path of the input file.



Encoding:
The type of encoding used, such as Base64.

Message Type:
The recognized file format of the file such as jpg or gif, or “Unknown” if it can not be determined.

Parts:
The number of pieces found and expected, or -1 for “unknown”.

Missing Parts:
The list of missing pieces (if any).

Starts & Ends:
This is used to determine if a file is complete. There should be at most one more end than start.

Original filename:
When the original filename differs from the filename highlighted in the Output Files listbox, it will be shown here. If you click on this item,
the filename will be copied to the clipboard. This allows for easy renaming.

Log Window

This is a window that shows the history of file activity, and any errors that are encountered when extracting files. Decoding errors are
shown with the line number of the error.

The Log Window is enabled from the Options Menu.

Note this window differs from most dialogs in that it can be resized, and remembers its position between uses. Also, information is
written to the Log Window even if it is not enabled. When the Log fills up, the oldest information is discarded. The newest information is
at the bottom of the list.

The Log Window information is cleared when the Clear button is pressed either in the Main dialog or the Log Window.

Monitored files

A file that is marked with > in the Input Files List, is automatically monitored for any additional data. This allows another program (such
as a News Reader) to write data to a file, and have UUDWin automatically process the file, updating the Output Files Listbox. Double-
click on the file to toggle monitoring. If a monitored file gets smaller or is deleted, it will be removed from the Input Files list, and all
Output Files it contained will be removed.

DDE support

DDE (Dynamic Data Exchange) is a simple mechanism for sending data or commands between running programs. UUDWin supports
several DDE Execute commands, which allows another program to control UUDWin, effectively turning it into a decoding engine. When
running automated, UUDWin will not show non critical error message boxes

Supported DDE operations are:

Open - [open("filename")] Loads and processes the specified file.

Extract - [extract("path")] Extracts all of the complete files into the specified directory.

Clear - [clear] Removes all files and resets UUDWin

Purge - [purge] Removes all complete and partially complete output files.

Quit - [quit] Terminates UUDWin.

DDE commands should be sent when linked to the “System” topic.



The service name is the same as the EXE name, “UUDWin”, and may be found in the registry under
\\HKEY_CLASES_ROOT\UUDWin\shell\open\ddeexec\application.

If UUDWin is busy processing a command, it will return DDE_FBUSY to any additional DDE commands.

Working Directory

The Working directory is used to store temporary files when launching an application, pasting data
from the clipboard, dragging files from the Output Files listbox, or extracting BINHEX encoded
data.

You will need enough free disk space to hold any files you extract in the course of launching an
application or dragging files, plus any clipboard data, plus about 140% more than the largest
BINHEX file you wish to decode. Usually this is less than 2 Megabytes.

File Menu

Open
Invokes the File Open dialog .

Extract
Invokes the Extract dialog

Extract Stream ..
Enables Stream Extract mode. See Advanced Features.

Save Raw
Writes the selected output file in its original encoded format, sorted and filtered, allowing you to save a file for later decoding.
Automatically appends ".uu" for the extracted filename. See other features .

Exit
Exit the application.

Recent files
Open a previously opened file.

Alternate Data Streams

Alternate data streams are additional data stored with a file when the file is stored on the Windows NTFS file system, the default file
system on modern Windows operation systems. Normally data is written to a specified filename. Windows Explorer shows you this
filename, its size, modified date etc. However the NTFS file system also allows you to store other data in the same file using a data
stream of a different name. This was originally used to support Apple's Macintosh resource fork (& others) when Macintosh computers
used Windows Servers to store data. Microsoft currently uses this to store authors names, thumbnails, download sources etc.

You can use alternate data streams by appending a : to a filename with the stream name such as c:\temp\myfile.uu:somestream when
reading or writing files. When you open up c:\temp\myfile.uu you only see the contents of the original file, when you open up
c:\temp\myfile.uu:somestream you will see completely different data. That data is not included in the file size shown in Windows
Explorer yet it still consumes hard drive space. Alternate data streams can be stored with any writable file, even executables.

The DIR command in Windows Vista & higher can show you alternate data streams

Alternate data streams are lost when the file is copied to a FAT/FAT32 filesystem, uploaded to the internet, sent in email etc.

For more information, search the internet for Alternate Data Steam or ADS tools.

Report Format



The report generated by the /report command line paramter contains the following:

Subject: <subject from input>
InFile: <source file>
OutFile: <decoded output file>
OriginalName: (this is not always present) <Original decoded output filename if renamed by UUDWin>
Encoding: <encoding type>
DataType: <data type>
Parts: <x> found, <y> expected
Missing Parts: a-b,c,d-e
Extract Status: <status number>
<blank line>
<Additional Report Entries>

Encoding can be one of:
"?", "TXT", "UU", "XX", "B64", "HQX", "yEnc","QP", "BNews", "X-Face", "Face"

DataType can currently be one of:

"unknown", "jpg", "zip", "gif", "wav", "avi", "bmp", "doc",
"mid", "exe", "hlp", "ps", "au", "voc", "aif", "mpg",
"lha", "zoo", "png", "mov", "tif", "rtf", "txt", "htm",
"hqx", "sit", "sh", "tar", "tgz", "z", "gz", "oct",
"app", "img", "arj", "vid", "aud", "snd", "ra", "rar",
"pcx", "wri", "pic", "MSapp","pdf","mapi","mp3", "psd",
"jar", "ace", "iff", "vqf", "wmf", "prz", "ram", "sid",
"wmv", "wma", "xif", "7z", "apl", "ogg", "asf", "par2",
"swf"

Status can be: UNVERIFIED=0, TOOSHORT=1, OK=2, TOOMANY=3, NOSTART=4, and may be combined with the following values:
DATAERROR=32, FILEERROR=64 So a status of 34 means file was not missing parts, but had an extraction error

UNVERIFIED - File not extracted
OK - File extracted
TOOSHORT - File probably missing parts
TOOMANY - More pieces encounted than needed
NOSTART - Data missing starting part
DATAERROR - Errors encountered during decode
FILEERROR - Could not write file, I/O error encountered during decode

Quoted-Printable

MIME Quoted-Printable encoding differs from the other encoding schemes decoded by UUDWin in that it is used to encode files that
largely consist of printable characters. It is possible to represent a binary file through the use of hexadecimal representations of the
binary values. In this case, each encoded binary value is prefixed with =, and then followed by its uppercase hexadecimal
representation, i.e. =A2. A file composed only of hexadecimal Quoted-Printable characters would be more than 3 times larger than its
unencoded size. The advantage of Quoted-Printable encoding is that it can be used to preserve text formatting, and still be readable.

A Quoted-Printable encoded file may look like this:

Message-ID: <852816748@random-pc>
Mime-Version: 1.0
Subject: Messages going nowhere
Content-Type: text/plain; charset=US-ASCII
Content-Transfer-Encoding: Quoted-Printable



>=20
>=20
>This is a message encoded in a quoted-printable format.=0D=0AThe end of line is not here=20=
rather it is here!
>It is possible to read though.=
>=20=2D=2D=2D=20

yEncoding

This is an experimental encoding scheme. Unlike other encoding schemes that convert binary data into a limited set of text characters,
yEncoding takes advantage of the fact that most 8bit characters can pass through USENET unchanged. Only a few characters need to
be removed from the data stream to ensure successful transmission. But since it does not conform to the rules regarding transmission
of USENET messages, it may not work in all cases. However since the overhead of yEncoding is usually only 1-2% of the original binary
file compared to other encoding schemes which add nearly 35-40%, it has become more widely used. An advantage of yEncoding is
that the encoded message contains a 32bit CRC that can identify corrupted data.

Yencoding uses the entire 8bit set of possible characters except for NUL (0), CR (13), LF (10), the escape character ‘=’ (61), and
sometimes TAB (9) (depending on the encoding software). The encoding scheme is as follows: The first line contains “=ybegin” and
contains the file line length, filename, & filesize, and a part number if part of a multipart encoding. Then each byte is added to a
cumulative 32bit CRC.The value 42 is added to the byte, if the resulting byte is one of the reserved characters, the escape character ‘=’
is placed in the output stream along with the the calculated byte+64. Finally the last line contains a “=yend” sequence, the filesize, part
CRC value in hex, and a optional total file CRC if it’s the last part or a multipart archive.

A single-part yEncoded message looks like this:

=ybegin line=128 size=99 name=readme.txt
~rs}Js}JkJ}ry|~JƒoxmynonJwo}}kqoXJ74swkqsxoJpy|JkJwywox~JkJy|vnJs~ry~Jrƒzy~ro~smkvJ}s~k~syx}XXX
=yend size=99 crc32=261c2dc2

Filename

A filename in a message subject is considered to be a group of characters without space, a ‘.’, and another group of characters without
space, such as myfile.txt

Recognized file types

Recognized file type include:

Bitmap formats:
BMP (Windows), GIF, IFF, IMG, JPG (JPEG), PCX, PIC (Lotus), PNG, PS, PSD, TIF (Tiff), WMF, XIF

Audio formats:
AIF, AU, MID (MIDI), many MP3, OCT, OGG, RA (Real Audio), SID, VOC, VQF, WAV, WMA

Video formats:
ASF, AVI, MOV (Quicktime), many MPEG, RAM, WMV

Archive formats:
7z, ACE, ARJ, JAR, GZip, LHA (& LZH), RAR, Stuffit/SIT, ZIP, ZOO, Z

Other formats:
EPS (Postscript), EXE (Executable), HLP (WinHelp), PDF (Acrobat), PRZ (Lotus), WRI (MSWrite), Microsoft Apps - DOC (Word), PPT
(PowerPoint), XLS (Excel), PRZ, RTF, SH (shell script)

Edit Menu



Paste
Pastes text or files from the Clipboard for processing. Text pasted from the clipboard is treated just like any other file. It is scanned for
encoded files, and rejected if none are found. Encoded files are added to the Output Files Listbox and the file "Clipboard" is added to
the input files list. Files may also be pasted from the clipboard, and are added to the input files list like any other file.

Special processing is done to automatically scan for End Of Line characters, and insert them if unusually long lines are encountered in
the first 16K of the data. This corrects problems pasting data from popular E-Mail programs, which remove these characters.

Delete
Delete the currently selected input file from the Input Files Listbox. All Output files that depend on the deleted file will be removed as
well.

Clear
Remove all input files and output files. Same as clicking on the Clear button.

Copy
Extracts the file that has the focus in the Output Files Listbox, and copies it to the Clipboard. Note that this file is temporary, and should
be used before terminating UUDWin, or performing other drag & drop operations. If the file type is known and Windows supports that
type as clipboard data, the data will be copied as well. This works for types Text, BMP, Wave, and Tiff. And now JPEG, GIF & PNG.

Rename
Brings up theRename dialog to rename the file that has the focus in the Output Files Listbox. This is useful if you don't like the way
UUDWin has truncated the filename, or if the file extension is incorrect.

Rename from Subject
Brings up the Rename from Subject dialog for the files that are selected or have focus in the Output Files Listbox. This is useful if you
have many files with the same filename such as "01.txt" and you want to rename them based on the subject of the original post.

Remove
Remove all of the selected Output files from the Output Files Listbox. This doesn't delete anything, it just removes the entry from the list
of files that can be extracted.

Select All
Selects all Output files

Properties
Shows information about the Output file that has the focus. This is an alternative to clicking on the file with the right mouse button.

Options Menu

Preferences
Invoke the Preferences Dialog

Advanced Preferences
Invokes the Advanced Preferences dialog.

Toolbar
Enable or disable the toolbar.

Status bar
Enable or disable the status bar.

Log Window
Enable or disable theLog Window.

Sort Files
Enable sorting of files by name. Uncheck this when files are being added automatically via Input File Monitoring, to keep the order of the
Output Files Listbox from changing.



Always On Top
Makes UUDWin the topmost window.

Help Menu

Contents
Displays the help file table of contents.

Search
Searches the help file for a topic.

Using Help
Displays instructions on how to use Help.

About
Invokes the About dialog which shows program version and copyright information.

UUEncoding

Three 8-bit values are split into four 6-bit values starting with the most significant bits. Then 32 is added to each value to map it into a
plain text character. A filename and protection mask is provided on the first line, which starts with “begin”. Each line is prefixed with an
encoded value indicating the number of decoded bytes in each line. For all lines except the last, this should be 45 or “M”. The 2nd to
last line of data can be less than 45 decoded bytes long, followed by the last line of data containing 0 bytes. Finally the file ends with
only “end” on the line. There are many variations of this format. Some put checksum characters at the end of each line, some provide
information on the total number of bytes in the decode file, some provide a checksum for the entire file. Also there are some encoding
schemes which follow the uuencoding rules, but which map the uppercase character to lowercase.

UUDWin will calculate checksums for each line if they are present. It will also decode all standard and nonstandard variations I’ve seen,
including files encoded with lowercase characters!

UUEncoding uses the character set:
"`!"#$%&'()*+,-./0123456789:;<=>?@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_"

A UUEncoded file looks like this:

begin 644 filename

M5VAY(&%R92!Y;W4@9&5C;V1I;F<@=&AI<S\@1&]N)W0@>6]U(&AA=F4@86YY
7=&AI;F<@8F5T=&5R('1O(&1O/PT*#0H`
`
end

XXEncoding

XXEncoding uses the same rules as UUEncoding, but uses a different character set. It does not use the space character in it's encoding
scheme which keeps some mailers from damaging files.

Three 8-bit values are split into four 6-bit values starting with the most significant bits. A filename and protection mask is provided on the
first line which starts with “begin”. Each line is prefixed with an encoded value indicating the number of decoded bytes in each line. For
all lines except the last, this should be 45 or “h”. The 2nd to last line of data can be less than 45 decoded bytes long, followed by the last
line of data containing 0 bytes. Finally the file ends with only “end” on the line.

UUDWin will calculate checksums for each line if they are present.

XXEncoding uses the character set:

"+-0123456789ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz"



A XXEncoded file looks like this:

begin 644 filename
hJqVt643mNG-tPrIUN4JXPqFdPaQUR4VdQnwUF4xi7rEUSKxp64VVRaIUMKtt
LR4VdPaQUMaJoR4Jm65Fj64FjDko81EdY
+
end

Base64

Three 8-bit values are split into four 6-bit values starting with the most significant bits. Line length must be shorter than or equal to 76
characters. In addition there must be a MIME Content-Transfer-Encoding: Base64 header before the start of the encoded data. The last
line may be padded with `=`. There are a number of other rules concerning MIME files that are best covered in detail elsewhere, such as
RFC 1521.

Base64 encoding uses the character set:

"`ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz0123456789+/"

A MIME Base64 encoded file may look like this:

Message-ID: <852816749@random-pc>
Mime-Version:1.0
Subject: Check out the attached file!
Content-Type: application/octet-stream; name="myfile"
Content-Transfer-Encoding:base64
Content-Disposition: inline; filename="myfile"

V2h5IGFyZSB5b3UgZGVjb2RpbmcgdGhpcz8gRG9uJ3QgeW91IGhhdmUgYW55dGhpbmcgYmV0dGV
yIHRvIGRvPw0KDQo=
-----

Binhex

Binhex is a format that was developed to enable Apple Macintosh computers to send their files through Mail and the Internet. It
maintains Apple's unique file format by encoding the filename, time, resource fork, and data fork. It is similar to other encoding schemes
in that it converts three 8-bit values into four 6-bit values, but it also include run length compression, which can compensate somewhat
for the increase in encoded file size. UUDWin can decode Binhex4 encoded files only. Since UUDWin was designed for Windows, it
automatically decides which part of the Binhex file to decode, either the resource fork or data fork, whichever is larger. This works most
of the time since files sent to non-Apple users, usually have one fork. Binhex can be used inside of MIME encapsulated files, or by itself
like UUEncoded files.

Binhex4 uses a the character set:

"!"#$%&'()*+,-012345689@ABCDEFGHIJKLMNPQRSTUVXYZ[`abcdefhijklmpqr"

A Binhex encoded file looks like this:

(This file must be converted with BinHex 4.0)
:#N**6NK&@#j8@&3!9%9B9(4dH(3!!!!!!$`!!!!!A+98D'Pc)'Pc)'%J3QPZ5'9
i0#"PEQ0[C'9N)'ePFh0KCf8Z)%9RB@3X)(P[G5GfC5"NC@0[C'9N)'Pd)3h'k!!
!:

BNews



BNews in an old encoding format that originally was developed for users of a Belgian ISP called Telenet aka Pandora, nicknamed
Bommanews. B-news was used to reduced the overhead imposed by Base64 & UUEncoding. It has since been replaced by YEnc, but
messages occasionally leak out onto the internet in this format.

[from b-news.sourceforge.net]

When encoding binary data, B-News first splits the data into 40 byte chunks. These chunks are regarded as a single 320-bit integer
number. The last chunk is zero padded to fill 40 bytes.

The encoding uses the characters from 0x20 to 0xFF (224 different characters). So the 320bit number is encoded using base-224
representation. 0x20 is added to each digit to move result out of the ASCII control-character range resulting in a number from (0x20 to
0xFF) 40 byte chunks are used because base 224 encoding requires exactly 41 bytes to encode it.

Encoded data is written in 247 character long lines (5 block) chunks.

The first line contains the header consisting of the filename and size and optional CRC.

<<BPST File=[myfilename.ext] Size=13978 CRC32=0 !BPST>>

UTF-7

UTF-7 is a method for encoding Unicode characters into standard ASCII along with shift sequences to encode characters outside that
range. Unicode is a 16bit-character format.

UUDWin does not support Unicode character output, but it will preserve the lower 8bits of the encoded charactes, which allows access
to the the extended ASCII character set, and reserved characters that are not allowed in MIME messages. When a text message is
encoded in UTF-7, UUDWin will automatically convert it to standard ASCII when the file is extracted. Unconvertable Unicode characters
are decoded as ".".

In addition, Message subjects may be encoded in UTF-7 format. UUDWin decodes these as well in order to determine filenames and
part numbers that may be embedded.

File Open dialog

Select one or more files to be processed by UUDWin. UUDWin keeps track of the files that have been recently opened. Select these
from the bottom of the File menu.

File name
Select or type the name of the file you want to open. This box lists files with the filename extension selected in the ‘List Files Of Type’
box. Multiple files may be specified by using a space between each filename. When you click on a file with an alternate data stream, the
stream name is shown at the bottom of the dialog. Click on it to open the stream. (Not available when using Old Style Extract Dialog)

List Files of Type
Selects the type of files you wish to see in the File Name list. UUDWin will remember your last selection.

Encoded Files (*.UU, *.UUE, *.XXE, *.MM, *.B64 *.HQX *.NTX)
List all of the files in the directory with usual encoded file extensions.

All Files (*.*)
List all of the files in the directory.



Common Files (*.TXT, *.HTM)
List all of the files in the directory with these common file extensions.

UUEncoded Files (*.UU, *.UUE)
List all of the files in the directory with UUencoded file extensions.

MIME Files (*.MM, *.B64)
List all of the files in the directory with MIME encoded file extensions.

XXEncoded Files (*.XXE)
List all of the files in the directory with XXencoded file extensions.

Binhex Encoded Files (*.HQX)
List all of the files in the directory with Binhex encoded file extensions.

Drives
Select the drive that contains the file(s) you want to open.

Directories
Select the directory that contains the file(s) you want to open.

Rename

Enter the new name for the specified file(s).

If you select multiple files to rename, you can specify a pattern using ‘?’ and/or ‘*’ to match a single character, or zero or more
characters respectively. All files that match the search pattern will be modified.

Note - unlike DOS, ‘*’ can be used multiple times in a search pattern.

For example, specifying test??.zip or test*.zip as a search pattern, and myfile??.zip or myfile*.zip as a replacement will rename all
testxx.zip files to myfilexx.zip. Replacement patterns should be chosen to ensure that resulting filenames are not duplicates.

Rename From Subject

A dialog to rename output files based on the subject line or message header of the encoded data.

Remove Text in "<>", "[]", "{}", "()"
Use these check boxes to remove enclosed test from the target filename.

Remove Multiple Spaces
Multiple spaces in target filename are converted to a single space

Append filename
Append the original filename to the target file.

Remove filename
Remove the original filename from the target filename

Remove Trailing Digits
Remove trailing digits from the target filename including extensions such as KB, KBytes, yEnc

Use Range:
Selects the range of characters in the subject to process. Ranges can be specified by start - end. Additional ranges can be including
using ',' such as "5-20, 33-40, 50-" Ranges CAN overlap.

Drop Characters:
Simply remove the specified characters from the target filename



Remove Pattern:
You can specify a pattern to match a part of a subject. Patterns can include these special characters:
? - represents a single character
* - represents zero or more characters
# - represents one or more digits
< - represents any open bracket character ( [ { <
> - represents any close bracket character ) ] } >

Note - unlike DOS, ‘*’ can be used multiple times in a search pattern.

For example, specifying test??.zip or test*.zip as a search pattern, and myfile??.zip or myfile*.zip as a replacement will rename all
testxx.zip files to myfilexx.zip. Replacement patterns should be chosen to ensure that resulting filenames are not duplicates.

Specifying a pattern like # of # will remove any <digits><space>of<space><digits> sequence.

Substitutions:
You can create a filename with other data available in the message such as subject, date, time, author etc. By default the subject is the
only field used and is represented by %s. If you create a substitution like "Trevor - %s" all files will be prefixed with "Trevor -" before
using the original subject. The subject operations above will still apply to the %s part of the substitution.

List of Files, Subjects & Results
shows you the Original filename, Subject, and Target Filename.

Clicking on Rename will perform the requested rename operation & close the dialog.


